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1.

Introduction to Kernel for Lotus Notes to Outlook

Welcome to the user manual for Kernel for Lotus Notes to Outlook software, the most powerful,

professional and easy to use conversion software that helps you to convert unlimited NSF files and Lotus
Domino Server Mailboxes.

1.1 Using this Manual

This user manual is intended to guide users on using Kernel for Lotus Notes to Outlook. We suggest that
first time users should read this user manual completely and carefully before proceeding to use the
software. However, if you are an experienced user, you can use the table of contents to find out
information pertaining to the tasks that you need to perform by using Kernel for Lotus Notes to Outlook.

You can use the table of contents to navigate through different sections of this user manual. The table of

contents lists all the sections that are contained in this user manual in chronological order. The user
manual comprises the following sections:

= = =4 =4 =4 -4 -4 -4

T

Introduction

Getting Started

Software Interface

Convert NSF file to PST file
Convert Domino Server Mailboxes
Full Version

Support

Troubleshooting

Legal Notices

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of
this user manual, please go through the list of abbreviations, mentioned below, before reading the manual.

1.1.1 List of Abbreviations

NSF: Notes System Files

PST: Personal Storage Files

RTF: Rich Text Format

MS: Microsoft
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RAM: Random Access Memory

MB: Mega-Byte

GB: Giga-Byte

1.2 About Kernel for Lotus Notes to Outlook

Kernel for Lotus Notes to Outlook software is an email migration tool for Lotus Notes email client. This
software uses quick algorithm to convert NSF files to PST files and user mailboxes from Domino Server to
Exchange Server.

Kernel for NSF to PST accurately converts emails, contacts, and calendar items, sent items, notes,
alarms, tasks, appointments, address books, journals and Unicode characters. Software is equipped with
the option of saving converted NSF files into .PST or Exchange Server format. It is a great tool for
converting unlimited .NSF files to .PST files and supports direct migration from Lotus Domino Server to
MS Exchange Server.

1.3 Salient Features

Salient features of Kernel for Lotus Notes to Outlook include:

f  Accurate NSF file to PST file conversion

1 Converts unlimited .NSF file(s) to .PST/Exchange

1 Migration from Lotus Domino Server to MS Exchange Server
1 Direct access to Lotus Domino Server for migration

1 Direct access to MS Exchange Server

f Unicode Character Conversion

1 Recreates folder structure of .NSF file into .PST file and makes it easy to access with MS Outlook email
client

1 Option to save converted NSF file into .PST and Exchange Server format
1 Option to save and view converted file in Text or RTF format

1 Converts emails, attachments, images, notes, journals, appointments, tasks, schedules, to-do item list,
sent emails, drafts, alarms, rules, calendar, address book, folder and sub-folders

1 Supports Every Version of Lotus Domino Server, Lotus Notes, MS Outlook and MS Exchange Server.

1 Free demo to analyze capabilities of the tool before purchasing it, allowing saving of first 10 items of
every folder existing in the NSF file

1.4 Who Should Use this Software?

Kernel [
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Kernel for Lotus Notes to Outlook is an excellent tool indeed for system administrators, individuals,
technicians, who need to migrate from Lotus Domino Server environment to MS Exchange Server
environment or want to convert large NSF files from Lotus Domino Server to MS Exchange Server or MS
Outlook. Performing migration is a bit tedious task but with Kernel for Lotus Notes to Outlook, companies,
organizations, individuals can feel relaxed.

Kernel [
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2. Getting Started

Now that you have understood the features and potential of Kernel for Lotus Notes to Outlook, you are
ready to get hands on experience of the software. To start migrating from Notes to MS Outlook, you will
first need to download and install the software.

It is strongly recommended that before installing Kernel for Lotus Notes to Outlook, you should go through
the installation pre-requisites for the software to ensure that your computer is appropriately configured to
run the software.

2.1 Installation Pre-requisites

The various pre-requisites for installing and running Kernel for Lotus Notes to Outlook can be broadly
classified into two major categories i Hardware requirements and Software requirements.

2.1.1 Hardware Requirements:

The hardware requirements for installing the software are as follows:
Pentium Class Processor

Minimum 64MB RAM (128 MB recommended)

10MB for Software installation

= = =4 =4

Disk Space - Enough space to store the converted PST files

@ You should have at-least 10 MB of free disk space if you want to save 10 MB of
converted data.

2.1.2 Software Requirements:
The software requirements for installing the software are as follows:
2.1.2.1 Operating System Requirements
Supported operating systems:
1 Windows Vista
Windows XP
Windows 2003
Windows 2000

Windows 98

= = =4 =
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2.1.2.2 Lotus Notes & Domino Server Version Requirements
Supported Lotus Notes & Domino Server versions:
1 Lotus Notes 8.0, 7.0, 6.0

9 Domino Server versions: 8.0, 7.0, 6.0

2.1.2.3 MS Outlook Version Requirements
Supported MS Outlook versions:

I MS Outlook 97 and above (97, 98, 2000, 2002, 2003, 2007)

2.1.2.4 MS Exchange Server Version Requirements
Supported MS Exchange Server versions:

1 All versions of MS Exchange Server

@ MS Outlook and Lotus Notes should be installed on the system on which you are
performing the conversion.

2.2 Downloading Kernel for Lotus Notes to Outlook for the First
Time

After checking your computer with the prescribed system requirements for Kernel for Lotus Notes to
Outlook, you can download and install the software on your computer. You can buy the full version of the
software from any one of our authorized resellers i Element5, Asknet and 2CO.

If you want to try using Kernel for Lotus Notes to Outlook before buying it, you can download the
evaluation version from the following link:

http://www.nucleustechnologies.com/download-convert-nsf-to-pst.php

@ You can save the first 10 items of every folder existing in the .NSF file to PST file
format using the evaluation version of Kernel for Lotus Notes to Outlook; however, to
save the entire converted items you need to purchase the Full Version.

2.3 Install Kernel for Lotus Notes to Outlook

After downloading the installer file for Kernel for Lotus Notes to Outlook, you can install the software by
running the file. To install Kernel for Lotus Notes to Outlook:

1. Double-click the Kernel for Lotus Notes to Outlook installer. Follow the on-screen instructions.
The Setup Installation Complete screen will be displayed.

2. Click Finish to launch the software.

Kernel -
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2.4 Start Kernel for Lotus Notes to Outlook

To start Kernel for Lotus Notes to Outlook:
Click the Start A All Programs A Kernel for Lotus Notes to Outlook

Alternatively, you can launch Kernel for Lotus Notes to Outlook by double-clicking the shortcut icon
available on the desktop and Quick Launch icon.

2.5 Uninstall Kernel for Lotus Notes to Outlook

You may need to uninstall and re-install Kernel for Lotus Notes to Outlook. To uninstall Kernel for Lotus
Notes to Outlook:

1. Click Start A All Programs A Kernel for Lotus Notes to Outlook A Uninstall Kernel for Lotus
Notes to Outlook

A warning message will be displayed.

2. Click &resoto uninstall Kernel for Lotus Notes to Outlook.

@ Before proceeding to uninstall Kernel for Lotus Notes to Outlook, you must ensure
that the software is not running.

You can alternatively uninstall Kernel for Lotus Notes to Outlook from the Control Panel by performing the
following steps:

1. Click the Start Menu A Control Panel and then double click the Add or Remove Programs icon.
2. Select Kernel for Lotus Notes to Outlook and click Remove.
A warning message will be displayed.

3. Click Yes to uninstall Kernel for Lotus Notes to Outlook.

Kernel [

©Nucleus Data Recovery.Com Private Limitec Notes (o Quiieak



3. Software Interface

Now that Kernel for Lotus Notes to Outlook has been installed on your computer, you can start using the
software after getting acquainted with the software interface.

3.1 Menu-bar

The menu-bar of Kernel for Lotus Notes to Outlook comprises three main menus i File, Tools, and Help.

3.1.1 File Menu

The File menu comprises one menu item.

File | Tools Help

Exit I |-

Figure 3.1: File Menu

Menu item in the File menu:

Exit Select to close Kernel for Lotus Notes to Outlook software

3.1.2 Tools Menu

The Tools menu comprises one menu item.

[ Tools ] Help

Advance Settings
[T & 1 "I

Figure 3.2: Tools Menu

Menu item in the Tools menu:

Advance Settings Select this option to access View Folders which
are by default created by Lotus Notes. To view
them, you need to activate the 'Show View
Folders' option from the Advance Settings
window.

{ooe
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3.1.3 Help Menu

The Help menu comprises three menu items.

| Help |

= Help
1 Software hame page..

Abouk Kernel For Lotus Mokes to Qutlook

|

Figure 3.3: Help Menu

Menu items in the Help menu:

Help Selecttovi ew User 6s Help Manu
Notes to Outlook

Software Homepage Select to visit software homepage on our website
About Kernel For Lotus Select to view version-related and support information of
Notes to Outlook Kernel for Lotus Notes to Outlook

3.2 Tool-bar

The tool-bar in Kernel for Lotus Notes to Outlook is displayed below the menu-bar. The tool-bar provides a
convenient and user-friendly method to perform certain actions. Read the information in the table below to
find out about the tool-bar buttons:

Add File(s) Click to add and list .NSF file(s) for
conversion
Add File(s)
2 Add Domino Click to get access to Domino Server File
il File(s) Selection window which enables you to get
Add Domino File(s) connected to domino server and select .NSF

file(s) for conversion

Kernel G
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i Export Click to export selected .NSF file to .PST or
L7J Exchange Server file format
Export
Help Click to view Useros
= Notes to Outlook
Help
Buy Online Click to view product purchase page of Kernel
e for Lotus Notes to Outlook
Buy COnline

3.3 Status Bar

Status bar is displayed at the bottom of the softw
displayed on the status bar when you open the software. The Status bar also displays the t e x t 6CA
6 NUMOG , 06SCRLO® which respectively correspond to the

keyboard. If any of these keys are pressed, the color of the corresponding text will turn blue/black.

|www.nuc|eustechno|ogies.com CAP | MUM | SCRL |

Figure 3.4: Status Bar

3.4 Buttons Used

Apart from the standard options available in the menu-bar and the tool-bar, following are the main buttons
used throughout the software:

[ Add File(s) ] Click to add .NSF files from your computer

[ Add Domino File(s) ] Click to add .nsf files from Lotus Domino Server user mailboxes by
searching for the server and then listing the files

[ Remove File l Click to remove selected NSF file from the list

: Click to remove all the listed NSF files
[ Remove Al FI|ES]

Click to preview mail items of NSF database

Kernel [
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Export Click to export listed NSF file to .PST file or MS exchange server

3.5 Customize User Interface

You can add or remove toolbar buttons by clicking:

~ A Add or Remove Buttons A Standard in the toolbar and selecting appropriate buttons.

Kernel w .
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4. Convert NSF file to PST file

Now that you have complete familiarity of the user interface of Kernel for Lotus Notes to Outlook, you are
ready to perform migration. To convert .NSF files to .PST files:

1. Launch Kernel for Lotus Notes to Outlook.

K. Kernel for Lotus Motes to Outlook ver B.1 2.01 El @l@
 File Toaols Help
-\I ,\.\b\ v b \ ' '
® E H @ #
" addFie(S) AddDomino Fle(S) Expot  Hebp  Buy Online . DATA RECOVERY
@ Step1
Ploase select NSE file(s) or [ AddFle(s) | | . AddDominaFiels) | ||y Removefie | [ Remove alFies
Daming file(s) bo convert
File Path Sarvar
Step 2
el
£ »
Kernel
E Preview ] I Export
v ricleustachnologies .oom W LM

Figure 4.1: Main Window

2. Click the Add Files(s) button to browse and list .NSF file(s).

Kernel Q‘J
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K| Kernel for Lotus Motes to Qutlook ver B.12.01

: File Tools  Help

-9 ok I IL:
. [ . >
HiE| '\3 | 1 hd ‘-i-é" o
| aodFile(S) AddDominoFla(S) Expart  Help  Buy Onine » DATA RECOVERY

D Stept
| . addriets) | | AddpominoFie(s) | | ) RemoveFle | || Remove AlFies|

Please seleck NSF Flefs) or
File Path Server

Do filefs) bo convwert
|ﬂ 5 rsf--\artclesa,nsf

Ijl;:'l,mf--inarruas_nsi
| ] Enst=-Journal nsf

>

KER‘N}EIJI . — ] [ Export l

LM

Im.w.m.u:laustad‘mbjas.m
Figure 4.2: List of .NSF files

@ You can select multiple .NSF files to migrate in one export cycle. You can remove
any file from the list by selecting the file from the list and clicking Remove File.

3. Select any of .nsf file and Click Preview to view the NSF file content.

Kernel \‘7'i
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K| Kernel for Lotus Nates to Quilook wer 5.72.01

{File Tools Help
By T
P (9 =M EH @ #
: AddFie(3) AddDomino Fle(S) Expoet Help  Buy Onlne -

Y I
DATA RECOVERY

W Stepl
Pleass sefect MEF fils(s) or
Dormina File(s) b convert = 12 NSF File
13 (By Category)
[[)23 (Group Calendars)
=3 My Contacts)

023 (Rules)

5]

Step 2
Preview Emads of NCF

databwse (in case of single
NSF File sedaction only )

(13 Drafts

128 Follo Up

23 t§inksn-Categorized]
[¥].=) T

103 Junk Msis

(1.3 calendar

[} Sent

[ ToDo

1@ Trash

123 ($MAPIUsaCertscts)
=2 Journals

123 unkied

e Click any folder to view converted emails

e

P Subject |Date Size in Byte ~
._]w Sarch Insider: 02f27[20068 02:51:32 PM 15557
L Teckiepokbe Crackirg opan the C2f 2700 02220 P 17504
= ackie

| R arksting Section 2: Around the Het 02127[2008 10:50:28 PM 16125
._].Pcwtdtr Prirting Tips and Special  02/27/2003 1065450 PM 10737
_'_'IMM'SSEI\EH Saciaon 20 Around b Net 02027020008 11:20:08 PM 1557

% Al nBirict Errrercues Yrawr Sasch Frata T 113707 B LT s

% >

Section 2: Around the Net in Brand Mark etieg
] Marketing Daily <news@mediapost.oom

DRJ27)2008 10:51 28 PM
The Financisl Fost
Cott Corp.'s stock dived about 38% on the Toronto Stock
Exchange yesterday amid rumord that Wal-Mart would cuc
gpace and marketing support for the Jam's Choice brands
it supplies. The stock dropped 20% the day before,
folloving a report Friday that claimed Cadbury Schueppes

would gain more ahelf space ac Wal-Aart fof ice Royal )

Lt

Figure 4.3: Preview

4. Click Export after viewing the preview.

As soon as the Kernel for Lotus Notes to Outlook finishes exporting process, it asks you for the saving

option:
1 Savein PST

1 Save in Exchange Server
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¥ Kernel for Lotus Motes to Qutlook ver §.12,01

File Tools  Help
2 i \D H @ *
Fdd File(S)  Add Domeno Fle(S)  Export Help  Euy Onling ~ DATA RECOVERY
W Stepl e click any folder to view converted emadls
Please select NSF Flels) or =
Dioming Fle{s) bo comvert = Dihfl;:i: | ate | Size in Byte *
& Stepz (153 (6o O2/27/2008 (95032 PM 15957
" Ol ] open the D2/Z7/2006 DRZ2IZPM 1755
Proswvigny Ernuads of NoF = T i
dst b (i e of ingls |:|_:] (Al i Ar the: Net 02fZ7/2006 10:51:28PM 16125
HSF file selaction only ) ) Dj‘ ips and Specisl | 021272006 10:54:50 PM 10737
Step 3 0= (%) Save in PST : dreond the Net (2{27{2006 11:21:08 PM 15376
lect ared Save Folder in D_—}“ | . s o Tmmrchy FIEE T 8T AT B AT o
:ﬁ'-f,\'}..':li.'x:" EJ Dira ) Sarve in Exnchange Server ¥
PST fle or Exchang 3 Folo
o 123 (3tY
G the Net in Brand Marketing
[10& dunik wr e ol apost, C o =
- T [
12 Calendar 2272008 10:50:28 PM
[} Sent The Financial Post -
3 ToDo Cott Corp.'s stock diwved about 38% on the Toronto Stock
El':gﬁ Trash Exchange yesterday amid rumors that Wal-Mart would cut
()3 (fmarTussContact s) space and macrketing support for the Sam's Choice brands
D_'.'i Joumnals it suppliea. The stock dropped 20% the day before,
123 Untithed b4 ITollowing a ceport Friday that claimed Cadbury Scheeppes
KEENELI i > would gain more ahslf space at EWal-Harc for ics Royal (%
. I Back ] [ Expart
VA MRSl O L L

Figure 4.4: Save Options
Here we will consider Save in PST option.

5. On selecting Save in PST option, a window appears asking for PST folder path and PST file name.

X

File location

PST Folder Path | Giinisf-- I[...]

PST File Name : |user 1 PST-D6-une-0d |

[ OF. J [ Cancel J

Figure 4.5: File Location window

6. On clicking OK, software asks for saving format, whether you want to save in text format or RTF
format.

Looe
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Select Save Text Type

Pleaze zelect save format , Bt format can take mare time in 2aving

() Save emailz in test format - Fastest Speed
() Save emailz in tf format - Low Quality - Medium Speed

(%) S ave emailz in tf format - Best Quality - Lowest 5peed

ok |

Figure 4.6: Saving Format options

On successful completion of saving, Kernel for Lotus Notes to Outlook shows a confirmation message.

@ Emails and other items of .NSF files are successfully saved into .PST file which now
can be viewed with MS Outlook email client.

KERNE[Q;’
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5. Convert Lotus Domino Server Mailboxes

The process is almost same as above.
1. Launch Kernel for Lotus Notes to Outlook. Click Add Domino File(s) button.

2. A window named O6Domi no apBears which asks ifol domir®esénercnameoon |B
address.

R Erwrsrl for Lotus Nobes B Dullesk wer 3.1 201 EH 0 i =loi=]

File  Toolz Help

\ % }‘ ] . i) I
4 i DATA RECOVERY
Add File{%) Add Domira PielT) Bt Helb By Onire «

=]
Shep 1. Fird or Al the Doores Sofonl Mams , Thon sslect the Do Sofvel Mams hom e et
Q@ =epi
Pt bt SR Fls TR Akl Do Sarve I Egmrier Fle o] P A Fles
Enrarady [ 4] 10 Dofred
Draearas Srvmt Wi |
=
Saaaich Do Srv
Ghap 2 Salant tha rad M bslongeg b the nelaoted Domens Server ard ohol Al Buon
setsd | Unseman |
red Fibea |
| |
1 l 3
o~
Kernel
1: Fre v Esprart |
st Pl ek COM L

Figure 5.1: Domino Server File Selection window

@ Define the Domino Server name or IP address in the field or search for the domino
server in network with the help of Search Domino Server button. Kernel for Lotus
Notes to Outlook software will search for the servers if you click the Search Domino
Server button.

3. As the Kernel software gets connected to the Domino Server, it will ask for the ID file password to
obtain access to the server.

KERNE[QL!

©Nucleus Data Recovery.Com Private Limitec Notes (o Quifaak



Figure 5.2: Window asking for ID file password

4. Type password and click OK button. After that select appropriate .NSF file which is to be converted.

Kernel @
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Domino Server File Selection

~Shep 1: Find or Add the Dioming Server Hame | Then sedect the Domino Serves Name fiom the kst

[192762.0.75

Dioming Serves N

CH=MNDR FATLAL

Add Doming Servers I

Select A1 UnSeisctal |

“Shep 2 Select the recf Hes belongng to the selected Doming Server and cck Add bulton

Dosiric Serves rigf Files I

Ll ]

B teponts i
e rif

[ ramagert.rat
[ madasystem nsl
B kg nsd
B

Add

Figure 5.3: Selecting NSF files

Click Add button to list the files for conversion. A window appears which shows message that

&elected Files are added6 .

Click OK and continue with conversion process.

Click Export button once NSF files get listed.
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| Kernel for Lotus Mabes ta Dutlook ver H_12 .1

|File  Toolz Help

;.lﬁ.lzll

L, " I I
g9 I 9 4 ol busheen
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Figure 5.4: NSF files listed

@ Here you cannot view preview of the files by clicking the Preview button.

8. Next step is to choose the saving option: Save in PST or Save in Exchange Server.

Save Options x|

Fleaze zelect zave option

i Savein PST

% i5ave in Exchange Server

] I Cancel

Figure 5.5: Save Options
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9. Select Save in Exchange Server option and click OK button.

@ Kernel software will ask you to close every instance of MS Outlook (if running). It is
recommended to click OK on getting this message.

10. Now the software will create a connection with MS Exchange server. Define exchange server name or

IP address along with username to which you want to save email data of NSF file converted to Outlook
format.

Figure 5.6: Exchange Server Information window
11. Then select the saving format accordingly i.e. save emails in text format, RTF format and click OK.

12. Kernel software will then ask password for the user profile you have selected on the MS Exchange
Server. Type in the password and click OK.

CET =) (7.
Kernel [
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